
Inkscape Gcodetools Tangent A Axis Rug Tufting Tutorial 
  

 

 

This is the method that I use make my designs and generate the computer code to operate my 

RugBot to make custom tufted rugs. While this is what I do for my project, the basic process 

may be helpful for other projects that would benefit from having A-axis control for whatever tool 

you are moving around. This project started a few years back and Gcodetools is no longer 

actively supported but it still works if you use a matching older version of Inkscape. To make 

this tutorial I did a clean install of Linux and then installed Inkscape 0.92.4. I believe that this is 

the most recent version before Inkscape upgraded to using Python 3 which causes some issues. 

There may be work arounds to use more recent versions of Inkscape but for my use having 

working Gcodetools is more important, and I would rather be making rugs instead of trouble 

shooting software. On other Windows computers that I have installed newer versions of Inkscape 

to try it out, I had issues with using Gcodetools even when I uninstalled the recent Inkscape and 

tried to use 0.92.4, but with a “clean” install it hasn’t been a problem. 

 

This is not a tutorial on how to use Inkscape and those tutorials are abundant. If one knew how to 

code or make macros or whatever you could probably streamline the process, and please feel free 

to do it any way you would like. 

 

 
 

I start with my design, which is usually more interesting than this one for this tutorial and do the 

following steps. 



 
You need to make sure that all the parts of the design are “paths” and not “objects” so select 

them all and use “Object to Path”. 

 

 

With all the paths still selected “Combine” them. 



 

With everything still selected set the Stroke style width to 4.5mm, or whatever line spacing you 

need. Next select “Stroke to Path”, then back to stroke style and set the width to 0.5mm, Stroke 

paint to Black, and Fill to No Paint. 

 

This may sound cryptic, but paths are defined by their centerline, and strokes are defined by their 

outer borders, so this allows you to change one line into two parallel lines. 

 

 



 

 

Make sure everything is still selected and use “Break Apart” to ungroup the areas. 

 

 

 



 

You should now have the areas outlined and separated. I am not going to use the outer rectangle, 

so I deleted it, and I assigned random colors to each area to make the next steps easier to keep 

track of. 

 

Select an area line and then repeatedly “Duplicate” and “Inset” to fill the area with concentric 

lines. This is easiest to do with the keyboard shortcuts “Ctrl+D” and “Ctrl+(”. You will need to 

set the offsets by going to the Edit tab and then Preferences, Behavior and Steps. Adjust the 

“Inset/Outset by:” to the amount you want, in my case 4.5mm but make sure you have the unit 

set to “px”. Yes, this should be “mm”, but I think you will find that “px” works. 

 

Be careful not to create duplicate lines that are not offset since they will cause duplicate moves 

later on. You will notice these if you move a node or part of a line and there is still a line there. 

 



 
 

You should end up with something like this. 

 

 

 

 



 

 

Look for odd results such as the centers of disconnected segment of the same area. This doesn’t 

happen all the time, but it does happen. Delete the excess lines or they may cause duplicate 

machine moves later. 

 



 

 

While you could keep each line a separate path, I find it easier and quicker to stich the rug with 

the sub-paths connected together. Add extra nodes where you want to connect the sub-paths, 

break them apart with “Delete segment between two non-endpoint nodes”. You will have to 

repeat this many times so if you have a mouse or trackball with programmable buttons, it can 

assign the keyboard shortcuts to the buttons save youself much effort and time. (I use a Logitech 

M570) 

 

 



 

Now connect the sub-paths together by selecting the end points and connecting them with “join 

selected endnodes with a new segment”. For making rugs the precision of this is not really 

significant and can be corrected later if needed. 

 

 



 

 

In some cases, such as the top, right, and bottom sections of this example, you may end up with 

multiple sub-paths in any area. I like to select them and “Break Apart” from the larger path and 

assign them a contrasting color. This may or may not be significant with whatever you are doing. 

 

 

 

 

 

 



  

Even though at this point you can go ahead and generate Gcode files I go ahead and do the 

following steps to change the nodes to “smooth” which in combination with the correct Gcode 

can make your machine move smoothly without stopping at the end of every segment. Select an 

area and add some nodes by going to Extensions, then Modify Path, and then Add Nodes. 

 

 

 

 

 



 
 

You can play around with how many nodes you add but I usually use 4.5 and ignore the fact that 

units are stated as “px” when they are really “mm”. This may start to over-stress your computer 

so you may want to work with small areas, and it may help to zoom into an area so less nodes are 

displayed, even thought they are all computed. You also want to start saving frequently because 

we have now entered the realm of potential computer crashes. 

 



 

While you have all the new nodes selected make them smooth by using the icon on the tool bar 

or “Shift+S”. 

 

 

 

 

 

 

 



 
 

While you could generate your gcode from this path with its many nodes or you can reduce the 

number of nodes, which will reduce the number of lines of Gcode by using “Simplify” in the 

Path tab. The amount you simplify can be adjusted by opening Preferences and selecting 

“Behavior”, and to the right should be “Simplification threshold”. I use 0.0001 but you can try 

other values and see what happens. This may change some of the node types, so you want to 

make sure they are all selected and make them smooth again.  

 

At this point you may want to check the way your path looks and make any edits as needed. 

Sharp angles sometimes get flared out some and need to be moved, and sometimes arcs get too 

close in the center of an area. 

 

 

 

 

 

 

 

 

 



 
 

It is now time for Gcodetools! First go to “Extensions”, then “Gcodetools”, and then then 

“Orientation points”. 

 

In most cases you can accept the defaults. In my process I don’t actually use any Z moves or 

code, but I don’t bother to delete or alter them since they have no impact on my work. 



                                                                                                                                                       

The orientation points are actually text that can be moved or edited as needed (I don’t) but doing 

so may have impact on what your machine does later. 

 



                                                                                                                                                         

Next you need to set what tool you want Gcodetools to use when generating the Gcode. 

 



                                                                                                                                                               

In our case we want to select “tangent knife” and apply. 

 

 

 



 

 

Somewhere on your Inkscape document this green box will appear. You may need to zoom out to 

find it or need to select it and move it off your drawing.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                                                      

The information in the green box can be edited with the Inkscape text tool. If you make an 

Inkscape template with the changes to the green box, and open new projects from the template, 

you don’t have to edit the green box every time. The first item you need to edit is to change the 

“4th axis scale” from “1” to “57.2958”. Gcodetools calculates in Radians, and most CNC 

programs want degrees, so 57.2958 does the conversion. You can change the other settings and 

my usual machine travel speed is 1680 mm/min, so I change “feed” to that. The other settings are 

not significant to me, so I leave them alone. 

 

You can also change these settings in the file “gcodetools.py” so that they are always what you 

want. On my PC the file is found at: This PC > Local Disk (C:) > Program Files > Inkscape > 

share > extensions. Search around in there and make changes as needed to the tangent knife 

settings. The parts you want to change are just text files, so you don’t really need to know Python 

or coding. Just look for what looks like what you need, change it, and then see what happens. 

You may want to take notes of what you changed, where it was, and what it was before you 

changed it. Some of the other “tools”, such as “plasma” in Gcodetools have settings for such 

things as “gcode before path” or “gcode after path” that may be useful, but for some reason 

aren’t options for the Tangent knife tool. In gcodetools.py you can snoop around at the other tool 

settings and then copy the settings you want into a similar place in the section for Tangent knife 

and add the code you need. If I can do it, you probably can too.   

 

One other anomaly that I experienced in the past was that some of the gcode that was generated 

would occasionally be in some sort of exponential expression that my machine would reject. If 

this happens to you, you can search in the gcodetools.py file for any instances of A%s and 

change them all to A%f. I don’t know what any of this means but it works. 



 

 

 

To write the gcode open Extensions > Gcodetools > Path to Gcode. 

 

 



  

Start with the “preferences” tab. In “File:” enter what you want to call the file and be sure to 

include the appropriate file type. For LinuxCNC which I use it is “.ngc”. Other software may 

require different file type names. It is my understanding that this doesn’t change the generated 

gcode in any manner but just effects the file name it is saved as so you can rename your files 

later if needed. The “add numeric suffix to file name” is nice in that you will get files listed as 

tutorial_001.ngc for the first file and then tutorial_002.ngc for the next file written etc. I don’t 

use Z axis moves so I don’t care what the safe height is, but it may be important to you. Make 

sure the units are what you want for your machine. I use “Round all values to 4 digits” just to 

make the files easier to read but you may want to try other settings for some reason. 



 

 

I don’t use Z axis so I don’t change the scale. “Minimum arc radius” is a bit of a mystery but I 

find 0.05000 works for me. It seems that changes in this setting may contribute to some problems 

including causing “Radius Format Arcs” being mixed in with the preferred “Center Format 

Arcs”. I don’t understand this but I need gcode like “G02 X #####  Y ##### Z ##### I ##### J 

##### A ####”, and if it looks like “G02 X ##### Y##### Z ##### R ###### A ####” and it 

doesn’t run, then “minimum arc radius” may need to be adjusted. It may also be that nodes are 

too close together and the “simplify” step may also help. I don’t really know but it seems to 

work. 

 

 



 

 

With the paths you want to write gcode for selected, open the “Path to Gcode” tab. You must be 

in this tab to write gcode, if you select “Apply” in any of the other tabs it will throw and error 

and tell you to go to the Path to Gcode tab. Basic interpolation tolerance refers to how closely the 

generated Gcode will follow the path of your drawing. Making rugs does not require really tight 

tolerance and I think having it a little loose in my case makes for more rounded corners which 

run smoother and fasters. For other applications you may want to adjust this if your corners are 

getting rounded off too much. If you zoom in on the Inkscape drawing after the next step, you 

can accurately see the drawing path and the tool path and evaluate if the tolerance meets your 

needs. I don’t think “live preview” does anything other than maybe slowing down the computer. 

Press apply and wait for something to happen. 

 

 

 



 

 

Gcodetools adds the path of the Gcode onto the top of the Inkscape drawing. Purple and green 

colors are arcs and the pink color represent straight segments. The arrows show the direction of 

movement. If the direction is not what you want, you can delete the gcode markers by selecting 

the line with the Inkscape selection tool and deleting it. You should go to the file folder where the 

gcode file you don’t want is and delete it too. Go back into Inkscape, select the line you want to 

change the direction of and under the Path tab select “Reverse”. When you use Gcodetools to 

generate the path again you will see the arrows pointing in the correct direction.  

 

To know which way the path is going to be going before generating Gcode you can add end 

markers to the line in the Fill and Stroke section of Inkscape. The markers do not end up in the 

gcode file in any way, so you can leave them in the drawing if you like. 

 

 

 

 

 

 

 

 

 

 

 

 



 

  

You have Gcode! Use a plain text editor to make any changes you need to the resulting Gcode 

file. Do not use a word processing program for this or bad things will happen. I like Notepad++ 

on the PC and Gedit seems good on Linux. At the beginning and end of the file you will find a 

little note that the “Header” and “Footer” were generated by Gcodetools and that you can add 

your own by including files in the output directory. This seems odd to me, but it actually works. 

For my RugBot I needed certain thing to happen before and after the file ran. I needed the needle 

mechanism to be fully retracted against a sensor before any XY moves and other details, so I 

wrote out the header gcode and saved it as a file named “header” and put it in the same folder 

that I listed in the Preference tab in the Path to Gcode extension. I did the same with the little bit 

of Gcode I needed to be in the footer and saved it as a file named “footer”. I don’t think you need 

a .txt file type for this, but I could be mistaken. 

 

Remember that if you want special Gcode before or after sub-paths you will need to add that to 

the green box by going into the gcodetools.py folder in the program and altering it. 

 

For my use I also need to edit each file to smooth it out for my machine. The first thing I do is 

change the first G01 A #### move of each sub-path to G00 A ####. This rotates my toolhead into 

position at a rapid speed, instead of a travel speed, which saves time, and also makes the next 

step possible. 

 

 

 

 

 



 

 

 

Gcodetools generates an A-axis movement that follows the arc when in motion, and then 

generates an A-axis move between segments to position the knife for the next segment. There are 

also some “lift-knife” settings that may or may not work usefully for an actual knife, but I don’t 

need that feature. Having the separate A-axis gcode lines can also cause some slow downs on the 

RugBot so I remove them for doing “Find and Replace” by searching for “G01 A.*” which is a 

regex, so I have “Regular expression” checked when using Gedit. Notepad++ doesn’t seem to 

need this distinction. This finds all the instances of lines that start with G01 A and deletes them. 

There is probably some way to get it to remove the blank lines, but they don’t seem to effect 

anything so I haven’t looked for a solution to the non-problem. 

 

This should give you enough information to maybe figure out something that works for you if 

you need to generate Gcode for a tool that needs to tangentially follow the direction of travel, 

such as a tufting head on a RugBot. It works for me. All the conversations about the development 

of Gcodetools is available at the location listed under the “About” heading when you first select 

Gcodetools in Extensions. Some of the other areas such as “Area” can be useful if you need 

them, which I don’t.  Nick did a great job in getting Gcodetools figured out and working as well 

as it does and helped me out numerous times. The forum is no longer being actively monitored 

but there may be some answers there if you look. If you read Russian, there may be even more 

info on the non-English part of the site. Remember that if you start off with a clean installation of 

an older version of Inkscape, no more recent than .92.4 you will probably have less issues. 

 

There are some videos of mine on the YouTube under the username of BadgeBond that may be 

of interest, but they are all obsolete to me and undocumented improvements have been made. 



There are some conversations about details in the forum section of LinuxCNC.org that include 

the files from my Linuxcnc system that may offer clues how to synchronize stitch length/speed to 

the movement of the machine. There may be other discussions out there, maybe in OpenBuilds 

and I usually try to reference things under RugBot. There are also commercially available 

machines and software that probably work really swell but I am cheap and just a hobbyist. 

 

Good luck!  

 

 

 

 

 

 

 

 

 


